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Overview

Sybase® CEP Eclipse plug-in enables you to use Eclipse to develop and manage Sybase CEP
applications.

Most of the information you need to develop a program with the Continuous Computation
Language (CCL) is contained in the standard Sybase CEP documentation. These pages
present information specific to the Sybase CEP Eclipse plug-in.

Specifically, you may also need to read the following documents:

• The Sybase CEP Getting Started tutorial guides you through exercises with Sybase CEP
Studio to define basic concepts. Note that you cannot use files created with Sybase CEP
Studio in Eclipse, nor can you use files created with Eclipse in Sybase CEP Studio.

• The Sybase CEP CCL Reference provides syntax and usage information for CCL
statements not described in this document.

• The Sybase CEP Programmer's Guide covers basic CCL programming from a how-to
perspective.

• The Sybase CEP Studio Guide covers the Sybase CEP Studio development application,
but many of the concepts presented there are relevant to the Sybase CEP Eclipse plug-in.

Overview
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Installing the Sybase CEP Eclipse Plug-In

A description of steps required to install the Eclipse plug-in in Sybase CEP.

1. Locate the CEP Eclipse Plug-In file included in the root of the CD, titled
com.sybase.c8.eclipse.plugin.jar. The file's name may be date stamped,
for example, com.sybase.c8.eclipse.plugin.3.0.0-20092522.1-
release.jar.

2. Copy the plug-in file to the plugins directory under your Eclipse installation directory.

3. Start (or restart) Eclipse.

Installing the Sybase CEP Eclipse Plug-In
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Creating a Sybase CEP Project

Create new Sybase CEP projects in Eclipse.

1. On the File menu, click New and then click Project.
2. In the New Project window, click Sybase CEP and then Sybase CEP Application to

specify the Sybase CEP Application wizard.
3. Click Next.
4. Specify the name of your project in the text box and, if you want it to be saved in a location

other than the default, clear the checkbox and specify a location.
5. Click Finish.

The Package Explorer shows the components of your new Sybase CEP project:

• The bin directory contains compiled query modules with a .ccx extension. If automatic
builds is turned on, your new project is already built and the corresponding .ccx file is
placed here.

• The modules directory contains CCL query modules with a .ccl extension.

Creating a Sybase CEP Project
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• The file with a .ccp extension is the Sybase CEP project file.

Your new project includes a single module file that contains simple CCL code defining a
typical module structure, as displayed in the editor. Notice that the text is color-coded based on
CCL reserved words and comments. This is where you write your own CCL code.

Create an additional module by following these steps:

1. On the File menu, click New and then click Other.

2. In the New window, click the plus sign next to Sybase CEP and then click CCL File to
specify the Sybase CEP CCL File wizard.

3. Click the modules folder under your existing project folder and then type the name of the
module into the File name text box.

4. Click Finish.

Next

Each new module contains the same starter CCL code.

For more information about CCL, see CCL for the Plug-In on page 7 and the Sybase CEP
CCL Reference.

For more information about the components of the Sybase CEP Eclipse plug-in, see The User
Interface.

Creating a Sybase CEP Project
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CCL for the Sybase CEP Eclipse Plug-In

Sybase CEP Eclipse plug-in enables users to write Sybase CEP applications in Continuous
Computational Language (CCL).

This page provides information about two CCL statements not covered in other Sybase CEP
documents: CREATE MODULE and LOAD MODULE.

Your application can contain any of the following statements, each of which is described in the
Sybase CEP CCL Reference:

• IMPORT
• CREATE SCHEMA
• CREATE FUNCTION

Syntax

In addition, your application must contain one or more module definitions, using the CREATE
MODULE statement described here:

CREATE MODULE

create_module_statement:
     CREATE MODULE 
module_name
           module_statements
     END MODULE ;

module_statements:
     { module_statement ; }

module_statement:
     create_stream_statement         |
     create_parameter_statement      |
     create_schema_statement         |
     create_function_statement       |
     create_variable_statement       |
     create_window_statement         |
     create_public_window_statement  |
     query_statement                 |
     database_statement              |
     delete_statement                |
     set_variable_statement          |
     load_module_statement           |
     attach_adapter_statement

Note that module definitions (CREATE MODULE statements)cannot contain other module
definitions. Module definitions can contain CREATE SCHEMA and CREATE FUNCTION
statements. The scope of such statements is the current module. The Sybase CEP CCL

CCL for the Sybase CEP Eclipse Plug-In
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Reference describes each of the statements listed in the definition of module_statement, with
the exception of the LOAD MODULE statement, which is described here:

LOAD MODULE

load_module_statement:
     LOAD MODULE 
module_name
 AS 
load_name
     
[ STREAMS
          module_streams_bindings_list ]
     [ PARAMETERS
          module_parameters_bindings_list ]
     [ PROPERTIES
          module_properties_list ]
     ;

module_streams_bindings_list:
     stream_binding 
     {, stream_binding }

stream_binding:
     
stream_name
 = 
stream_value
module_parameters_bindings_list:
     parameter_binding 
     {, parameter_binding }

parameter_binding:
     
parameter_name
 = 
parameter_value
module_properties_list:
     module_property
     {, module_property }

module_property:
     module_property_name = 
module_property_value

Note:

• Names (module, streams, parameters, and properties) are case-insensitive.
• stream_value can either be the name of a stream in the loading module or a string

containing a ccl:// or http:// stream URI.
• For more information about stream bindings, see the Creating Data Stream Bindings

section of the Sybase CEP Studio Guide.

CCL for the Sybase CEP Eclipse Plug-In
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• Valid values for module_property_value depend on the specified property, as described
below:

Property Value

GUARANTEED DELIVERY INHERIT | ENABLE | DISABLE

GUARANTEED DELIVERY MAXIMUM
QUEUE SIZE

integer

GUARANTEED DELIVERY MAXIMUM AGE interval

SYNCHRONIZATION USE SERVER TIMESTAMP|IN ORDER|OUT
OF ORDER|INHERIT

OUT OF ORDER DELAY interval

MAXIMUM DELAY interval

PERSISTENCE INHERIT | ENABLE | DISABLE

PERSISTENCE COMMIT INTERVAL interval

For more information about these properties and values, as well as additional information
about bindings, see the Editing Query Module Properties section of the Sybase CEP Studio
Guide.

Note: Modules cannot be loaded recursively, either directly or indirectly.

Example

The following code defines a simple module for calculating the CCI index:

// Define CCI module
CREATE MODULE CCI
    // Module interface
    CREATE INPUT STREAM Trades SCHEMA (Symbol STRING, Price FLOAT);
    CREATE OUTPUT STREAM Cci SCHEMA (Symbol STRING, CCI FLOAT);
    CREATE PARAMETER INTERVAL IntervalSize = 15 minutes;
 
    // Module implementation
    CREATE STREAM TypicalPrice;
 
    INSERT INTO TypicalPrice 
    SELECT
        Price, Cci.CCI
    FROM
        Trades KEEP 24 HOURS, Cci
    WHERE
        Trades.Symbol = Cci.Symbol
    ;
END MODULE; // CCI
 

CCL for the Sybase CEP Eclipse Plug-In
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To instantiate the module, use the LOAD MODULE statement:

/// Load the module definition
///
IMPORT "Finance/CCI.ccl";
 
CREATE MODULE Main
    CREATE STREAM CciShortStream;
    CREATE STREAM CciLongStream;
 
    /// @name CciShort
    ///
    /// instantiate the module with "1 minute" interval
    ///
    LOAD MODULE CCI AS CCI_Short
    STREAMS
        Trades = "ccl://server:6789/Stream/Ws/Source/TradesStream",
        Cci    = CciShortStream
    PARAMETERS
        IntervalSize = 1 minute
    PROPERTIES
        PERSISTENCE         = INHERIT,
        GUARANTEED DELIVERY = INHERIT
    ;
 
    /// @name CciLong
    ///
    /// instantiate the module with "15 minutes" interval
    ///
    LOAD MODULE CCI AS CCI_Long
    STREAMS
        Trades = "ccl://server:6789/Stream/Ws/Source/TradesStream",
        Cci    = CciLongStream
    PARAMETERS
        IntervalSize = 15 minutes
    PROPERTIES
        PERSISTENCE         = INHERIT,
        GUARANTEED DELIVERY = INHERIT
    ;
END MODULE;

CCL for the Sybase CEP Eclipse Plug-In
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Running a Sybase CEP Project

Begin a Sybase CEP project with a run configuration.

To create a new run configuration, follow these steps:

1. On the Run menu, click Run Configurations.

2. Click Sybase CEP Application and then click the New launch configuration button.

3. Specify a name for the run configuration and then choose the project from the Project
list.

4. Change the default values for Server URI (connection information for the server that you
want to run your project), Workspace (a Sybase CEP workspace), and Compiler
Arguments, if desired.

5. Click Apply.

6. Click Run.

Next

More information about URIs, workspaces, and compiler arguments can be found in the
Sybase CEP Integration Guide.

The Console displays debug information and, assuming the program is successfully compiled
and loaded, the message "Program was successfully started."

Note: if your Sybase CEP compiler is not in the default installation location (C:/Program
Files/Sybase CEP/Server/bin/c8_compiler.exe), you must specify the
correct location by clicking Preferences on the Window menu and then typing the path into the
Sybase CEP Compiler Path text box in the Sybase CEP Preferences area.

Also note that the Sybase CEP Eclipse plug-in does not support debugging CCL on the server,
so you cannot create debug configurations for Sybase CEP projects.

You can restart or stop a running Sybase CEP project with The Admin View on page 18.

Running a Sybase CEP Project
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The User Interface

A description of Sybase CEP Eclipse plug-in interface components.

• The Package Explorer shows the files comprising your Sybase CEP project. These files are
discussed briefly in Creating a Sybase CEP Project on page 5.

• The editor enables you to view and modify the contents of the individual files in your
project. See The Editor on page 14 for more information about this component.

• The Outline view displays the components of your project, including streams, adapters,
and windows. See The Outline View on page 16 for more information about this
component.

• The Console displays messages, including errors, about actions you take with the plug-in,
such as compiling, starting, and stopping projects.

Other components appear when you take specific actions:

• The Properties View displays schema and property information about a specific project
component. See The Properties View on page 16 for more information about this
component.

The User Interface
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• The Admin View allows you to manage running projects. See The Admin View on page
18 for more information about this component.

• Stream Viewers show you the rows passing through the streams and windows in your
project. See Stream Viewers on page 19 for more information about these components.

Opening the Editor view
The editor view enables users to view the content of an opened file. Users can also make
modifications through the editor view.

Query Module Files

When you create a new query module file, the Sybase CEP Eclipse plug-in automatically
opens it in the editor. Query module files contain the CCL code defining your project.

The User Interface
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Project Files

When you open a Sybase CEP project file with a .ccp file name extension, the editor displays
information about the project as a whole:

The three tabs are:

• Properties: displays high-level information about the project.
• Parameters: enables you to specify override values for parameters already defined within a

module.
• Bindings: enables you to specify bindings between streams in different projects.

See the Sybase CEP CCL Reference, the Sybase CEP Studio Guide, and the Sybase CEP
Integration Guide for more information about parameters and bindings.

The User Interface
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Other Files

While you can display Sybase CEP files from your project's bin directory in the editor, you
should not edit these directly. Enable the compiler to build those files from your CCL code.

The Outline View
The Outline view displays icons representing the different components of a Sybase CEP
project.

Components include streams, adapters, and windows. Right-clicking an item enables you to
open the CCL Properties View on page 16 with information about that specific component.

Viewing CCL properties
The CCL property enables users to view read only information.

Open the Ccl Properties View by right-clicking an item in the Outline view and then choosing
Properties.

The User Interface
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As you click different items in the Outline view, the Ccl Properties View changes to show the
schema definition and property values of the selected component.

You can copy the information from this view by right-clicking in an area outside the schema
definition table, and then choosing Copy. Pasting the results of such a copy operation looks
similar to this:

Stream name: StreamTrades
Stream schema:
1, Symbol, STRING_COLUMN_TYPE
2, Price, FLOAT_COLUMN_TYPE
3, Volume, INTEGER_COLUMN_TYPE
GuaranteedDelivery : inherit
GuaranteedDeliveryMaximumAge : 10 minutes
GuaranteedDeliveryMaximumQueueSize : 0
Synchronization : inherit
MaximumDelay : 1 second
OutOfOrderDelay : 1 second

The User Interface
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The Admin view
Open the Admin View from the Sybase CEP menu to monitor and manage running Sybase
CEP projects.

The top area of the view provides access to the following functions:

• The text box contains the default server URI, as specified in your Sybase CEP Preferences
on page 21. Change the information here if you want to connect to a server other than the
default. Click Connect to connect to the specified server. Once connected, the bottom area
of the view displays the workspaces and running projects on the server. Any messages
related to connecting to the server appear in the Console view.

• Use the Program buttons to restart or stop the running project selected in the bottom area of
the view.

• Use the Workspace buttons to create a new workspace or delete an existing one (which
must be empty).

The User Interface
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• Enter a character string in the Filter projects text box, followed by clicking the binoculars
button, will limit the display to projects with names that match the specified string.
Clicking the "X" button removes the filter.

Click a project name in the bottom area of the view to review status information about the
running project.

Click the name of a stream or window in the bottom area of the view to review the URI of that
component. Right-click a component to open a Stream Viewer on page 19 for that
component.

Stream viewers
The Stream Viewer displays rows that are passing through a specific stream.

Access the Stream Viewer by clicking Open Stream Viewer on the Sybase CEP menu. You
then type or paste the URI of the stream in the text box and then click Subscribe. Alternatively,
right-click the name of a stream in the Admin View and then choose View stream. This opens a
Stream Viewer with the URI of the selected stream already placed in the text box. Simply click
Subscribe.

Use the pause and resume buttons to control the display of rows.

The User Interface
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You can re-use the same Stream Viewer to view the data in a different stream by replacing the
URI and clicking Subscribe again.

You can have multiple Stream Viewers open simultaneously.

The User Interface
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Setting Sybase CEP preferences

Sybase CEP Preferences enables users to specify the defaults for Run Configuration, the
Admin view, and other plug-in functions.

Access Sybase CEP Preferences by clicking Preferences on the Window menu. In the
Preferences window, click Sybase CEP Preferences.

Here you identify the name of and path to the Sybase CEP compiler, arguments to pass to the
compiler when building your Sybase CEP modules, the URI of a Sybase CEP Server, and the
name and password of a user, if the Sybase CEP Server is configured to require user
authentication.

Setting Sybase CEP preferences
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